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PDP Staff Retirements

Julia Meade 
After nearly 16 years with PDP, 
Julia (Julie) Meade retired on 
January 30, 2020. Julie joined 
PDP in February 2004 as a 
Senior Education Specialist 
with the Department of Child 
Welfare. Julie worked on the Case 
Documentation training team 
during her entire career at PDP 
and was an asset to the department 
and training teams as a coach 

and mentor for new trainers. Julie’s years of experience in the 
child welfare field and her desire to meet the needs of workers 
and the families they serve led Julie to provide high-quality 
training and technical assistance. PDP thanks Julie for her 
dedication and her contributions. 

Leanne Friedlander
After nearly 16 years with PDP, 
Leanne Friedlander retired on
February 5, 2020. Leanne joined 
PDP in May 2004 as a Senior 
Education Specialist with the
Department of Computer Training 
Services. Leanne was responsible 
for the development of help systems, 
classroom and virtual classroom
trainings, and the preparation of
Release Notes for OCFS proprietary 

systems. She also worked with the Division of Child Care
Services, the Bureau of Adult Services, and Information 
Technology Services staff on systems trainings. Leanne was 
known for being thorough and detailed, and she was an expert 
editor. PDP thanks Leanne for her dedicated service, hard work, 
and contributions.

Cecilia Archer-Tucker
After 17 years with PDP, Cecilia Archer-Tucker retired on 
March 31, 2020. Cecilia came to PDP in December 2002 
as an Education Specialist and was promoted to a Senior 
Education Specialist in 2005. During her time with PDP, 
Cecilia worked in the Department of Temporary Assistance 
Training and the Department of Child Care Subsidy and 
Regulated Care Training. Cecilia led a variety of curriculum 

design/development and training 
teams, delivered training, coached 
and mentored staff, and aided 
the onboarding of new trainers. 
In addition, Cecilia served PDP 
as a Development Dimensions 
International certified trainer
and was a contributor to many 
PDP workgroups and strategic 
initiatives. PDP thanks Cecilia 
for her commitment to customer 
service, dedication, and wonderful 
contributions. PDP

videos that need to be captioned before they are shown 
in a training or conference. If an important video is 
demonstrating a process, include a verbal description 
of that process so an individual who is blind or has low 
vision knows what is being demonstrated. The audio of 
the verbal description can be added to the video, just as 
captioning can be added for an individual who is deaf or 
hard of hearing.

Make sure all materials are Section 508 
compliant.
All documents should be checked for the ability of a 
computer to read the material aloud using a “text-to-
speech” program. This is not as easy as simply creating
a PDF, Word, or PowerPoint document. To check a 
Microsoft Word document, go to File > Info > Inspect 
Document > Check Accessibility. This will review the 
document, inform you of any accessibility problems that 
might exist, and describe how to fix the problems. To 
check the accessibility of a PDF in Acrobat Pro, choose 
Tools > Accessiblity; in the secondary toolbar, click Full 
Check. PDP
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Accomplishing the challenge of meeting these standards has 
been demanding, and government at all levels has turned 
to higher education for direction. Higher education has 
embraced this responsibility and played a role in assisting 
with the ongoing evolution of digital government to provide 
for universal access and usability. Higher education has made
important contributions in applied research on e-government. 
The initial version of e-government was an informational 
“push” model. This model was one-directional and allowed 
for little transaction between citizen-users and government
(e.g., IT professionals and policy leaders). The research 
findings from higher education inf luenced the evolution of
e-government to a more interactive and highly functioning 
model well advanced from the push model. Consequently, as 
increases in IT capacity accelerated over the past decade, so 
did e-government performance. This has led to the current
state of well-directed, interactive, and responsive sites and
applications, including the capability of online interactive 
input from citizen users.

Today, higher education continues to guide the digital 
transition to e-government beyond its research role by 
providing other valuable services such as the establishment of 
benchmarks for e-governance, hosting forums, colloquiums, 
and seminars that bring together IT experts, scholars, policy 

makers, executives, and political 
leaders to exchange ideas about 
best practice. Additionally, 
higher education has provided 
an instructional platform for 
developing IT professionals and
supports the continuing growth of 
these professionals through ongoing state-of-the-art programs 
like those offered by the Departments of Computer Science 
and Electrical and Computer Engineering at the College of 
Engineering and Applied Sciences, University at Albany.

Digital government has become ubiquitous in a short time, and 
the transition, like other paradigm shifts, has not been smooth, 
expedient, nor inclusive. Accessibility and usability are not 
yet universal. As more citizens rely on technology for business 
purposes and civic engagement, government must become 
more proficient in providing these services by means that 
reach all constituents. The ongoing success of e-government 
may come to depend on the effectiveness of higher education 
to work with government on its continuing commitment to 
the development of websites and web applications that enable 
participation for all, thereby achieving the goal of universal 
access and usability. PDP
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when conducting usability testing. Second, they hold 
government accountable for having accessible and usable 
websites. It is the responsibility of citizen-users to provide 
clear, specific, and authentic feedback, and it is IT’s
responsibility to implement the changes with the support of
political policy leaders. 

Continued on page 6
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Considering the current, unprecedented, 
world we are living in, universal 
accessibility and usability is more 
important than ever. This is needed for 
education, government, commerce, as 
well as the general public.

Achieving Accessibility and 
Usability in E-Government: 
The Digital Challenge
Eugene J. Monaco  
Executive Director and Public Service Professor 
Professional Development Program 

Accessibility and usability have been defined as providing universal access for all, 
including those individuals with disabilities. Traditionally, this has meant physical 
access, as illustrated by the use of ramps and elevators in addition to stairs in 
public buildings and electric lifts on public transportation. A more contemporary 
and inclusive definition includes access to and use of information. Both definitions 
are important to consider when addressing the topic of accessibility and usability 
for those who use government services. As the day-to-day way of conducting 
government business has become increasingly electronic, people with disabilities 
and those who are socially and economically disadvantaged are increasingly at 
risk. The trend toward digital or e-government has presented a new challenge that 
needs to be addressed to provide inclusive service delivery.

E-government has changed what citizens have come to expect
and demand at local, state, and national levels. The rapid advance
of the internet into everyday life has brought new ways in which
government conducts business. The demand for open government
has spurred the call for transparency, participation, collaboration,
and increased access by the general public. Therefore, standards
for accessibility and usability in e-government are essential, and
Section 508 of the United States Department of Health and
Human Services Rehabilitation Act of 1973 has proven effective
in establishing baseline standards that achieve access for all.

These standards have been formulated at the intersection of 
information technology (IT) developers, political policy leaders, 
and citizen-users. Citizen-users, which include those with 
disabilities and their advocates, are essential to implementing 
access and usability in two ways. First, their feedback is essential 
Continued on page 5

User Testing: Sit Next to Someone ................................... Pg. 2 
Training with JAWS ............................................................ Pg. 4 
Tips to Make Training More Accessible .......................... Pg. 4 
News and Views .................................................................. Pg. 5 

http://www.pdp.albany.edu


4

Sit Next to 
Someone.  

Watch Them 
Do Stuff.

Ed Skawinski 
 PDP Manager
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1. Recruit users. 
If possible, they should represent your target audience. 
Compensate users for their time if you are able. Generally, 
aim for four to six users per test.

2.	 Schedule users. 
Leave enough time between sessions for notetaking and 
debriefing with your observers.

3.	 Welcome the user and explain the test. 
Use a script to ensure consistency among all users. The 
script should include telling users that they are not being 
tested–the user test is a test of the website. Tell users that 
they can stop the test at any time. Let them know they 
can ask questions, but that you may choose not to answer. 

4.	 The user sits down at a computer or with a 
device and is given the tasks (preferably a 
printed list).
Sit nearby so you can see both the user and the display. 

5.	 The user works through the tasks and “thinks 
aloud.”
This helps you better understand the user’s expectations 
and experience. You may prompt the user as needed but 
avoid leading the user. Let users fail. Their failure can 
demonstrate areas where the designers’ intentions are not 
clear. Remember, the website is being tested to see if it 
matches user expectations.

6.	 Be ready to end the test if necessary.
Stop the test if the user is completely frustrated or 
unwilling to continue for any reason.

7.	 Ask any additional questions. 
You may ask additional questions after the user has 
completed the requested tasks. Generally, you may ask 
about how well the website met the user’s expectations.

8.	 Thank the user.
Thank the user and provide information about 
compensation.

9.	 Debrief with your observers. 
Gather overall impressions, ideas, and recommendations.
Answer any questions your observers have. Discuss any 
issues with the test or procedure.

10.	Report your findings, make changes to the
website, and test again!

User testing is the most direct form of usability testing. Data 
from these tests can not only help improve the website you are 
testing but also inform design decisions for future projects, 
which saves development time and money. Ultimately, user 
testing can help designers and developers create a user-
centered work environment that considers users first. PDP

Training 
With JAWS
Roger Tadjbakhsh, 
PDP Senior Education 
Specialist

Several years ago, I began working with 
Job Access With Speech (JAWS). JAWS is a screen reader 
program developed by Freedom Scientific for computer users 
whose vision loss prevents them from seeing screen content 
or being able to navigate with a mouse. The JAWS screen
reader (which includes a built-in speech synthesizer) enables 
an individual who is blind or visually impaired to hear the
text displayed on a computer screen. Once installed, JAWS 
recognizes tags embedded in documents and websites. These 
tags can indicate the type of object within a document, 
describe images, and provide access to form fields. By using 
JAWS-specific hotkeys in conjunction with these tags, a user
can read, manage, and update information in a file or a form.
At PDP, we teach people how to work with JAWS so that
they can perform their jobs, whether it is editing a letter in 
Word, completing a reimbursement request in Excel or an 
online proprietary system, or filling out a client intake form in 
a web-based application. 

When working with JAWS, it is important to be mindful 
of the training challenges that can exist when we compare
experienced JAWS users to those who are learning to use 
JAWS for the first time or using JAWS with new state 
proprietary applications. I recall working with an experienced 
user who had configured the JAWS rate of speech for a high
setting (i.e., fast speaking). Now the user was using JAWS 
to read an unfamiliar state system. This combination made
it difficult for me to understand the information being read 
aloud by the computer, while also making it difficult for the
trainee to focus on the use of the new application. I quickly
learned that reducing the rate of speech to a lower speed 
resulted in a more effective training and an increased level of
comprehension by the trainee. 

Whether working with individuals who have vision loss or
others who need to understand how JAWS works to develop 
accessible files and applications, knowing that I can meet
their needs is a rewarding experience. My personal training 
style has also been affected positively. For example, today as a 
trainer I find more value in clarity and quality of instruction 
as opposed to the volume of information given. I welcome
the opportunity to support screen reader users and help
government work better. PDP
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a quality of how easy a product 
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focus on user-testing websites.

Usability guru Jakob Nielsen states, 
“On the Web, usability is a necessary 
condition for survival.”1  If your 
website or web-based product (e.g., 
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1 Neilsen, J. (2012, January 3). Usability 101: Introduction to Usability. Retrieved 
from https://www.nngroup.com/articles/usability-101-introduction-to-usability

WHY
 Test Usability?

different devices and in numerous situations. What may 
seem obvious to one person may not be obvious to others. 
Designers and developers shouldn’t make decisions based 
on their perception or use of the product. Instead, they 
should make informed decisions based on the behavior of 
users who used (or tried to use) the product. User testing 
is unique in that the testers (facilitator and observers) are 
getting as close as possible to what real users do—or try to 
do—with the product. The data gathered from these tests 
reduces guessing and opinion-based arguments among 
design team members. Developers have the data needed 
to improve their product based on the experiences of the 
people who will be using the product.

Simply put, user testing consists of 
sitting next to someone to “watch 
them do stuff.”2 A basic user test 
for a website would include a user, a 
computer or other web-enabled device, 
rvers, and a list of tasks for the user to 
site. The user is asked to perform the 
” the steps of completing them. 
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   Know?

Usability: 
The ability of users to 
achieve specified goals 
with effectiveness, 
efficiency, and satisfaction. 

Effectiveness: 
The ability to achieve the objective 
for which it was designed.

Efficiency:
The resources used to reach 
a goal are the lowest possible 
(e.g., fewer clicks, less time).

Satisfaction: 
Ability to generate a positive 
experience for users.

Sample Website User Test

Accessibility: 
The degree to which a product or 
system can be used by people with 
the widest range of characteristics 
and capabilities to achieve a specified 
goal in a specified context of use.

… the difference between3

&

the difference between?31

3 ISO/IEC 25010. (n.d.). Retrieved from https://www.iso25000.com/index.php/
en/iso-25000-standards/iso-25010?limit=3&start=3

Roger Tadjbakhsh

Tips to
Make 
Training 
More 
Accessible
Carolyn Malloch, Director  
UAlbany Disability Resource Center

The following are tips on making training more accessible 
and usable for the individual attendee.

Survey attendees. 
As part of your registration materials, ask if anyone 
requires assistance in the following areas:

•		 Dietary preference and/or food allergies
•		 Training materials and presentations:  

For example, “Do you need an assistive listening 
device or alternative communication assistance, such 
as American Sign Language or Communication
Access Realtime Translation (CART)?”

Assess the physical space. 
Make sure the trainings are scheduled in buildings 
that are accessible to people who use wheelchairs or 
have other mobility disabilities. 

Assess the technical abilities of the space.
Some buildings have a “loop” built into their audio 
system that individuals with hearing aids can access 
to hear people who use a microphone to speak. Make 
sure speakers use microphones so everyone can hear 
them, even those presenters who state that they don’t 
need a microphone because they can “talk loudly." 

Allow time to hire interpreters. 
If you are providing American Sign Language access 
for individuals who are deaf or low hearing, keep 
in mind that it takes time to schedule a qualified 
interpreter. You can include a deadline for requesting 
the service to allow time to schedule the interpreter or 
cancel if no one needs the service. CART—a real-time 
captioning service—is provided through a computer 
and microphone linked with a trained captioner who 
listens in while transcribing what is being said. 

The user reads the typed conversation in real-time on 
a computer screen. Also, consider that you may have 

Carolyn Malloch

2 Chisnell, D. (2008, December 23). Quick Cheap Insightful: Usability Testing in 
the Wild. Retrieved from https://www.slideshare.net/danachisnell/quick-cheap-
insightful-usability-testing-in-the-wild-presentation

https://www.nngroup.com/articles/usability-101-introduction-to-usability
https://www.slideshare.net/danachisnell/quick-cheap-insightful-usability-testing-in-the-wild-presentation
https://www.slideshare.net/danachisnell/quick-cheap-insightful-usability-testing-in-the-wild-presentation
https://www.slideshare.net/danachisnell/quick-cheap-insightful-usability-testing-in-the-wild-presentation
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The degree to which a product or 
system can be used by people with 
the widest range of characteristics 
and capabilities to achieve a specified 
goal in a specified context of use.

The ability of users to 
achieve specified goals 
with effectiveness, 
efficiency, and satisfaction. 

Effectiveness: 
The ability to achieve the objective 
for which it was designed.

Efficiency:
The resources used to reach 
a goal are the lowest possible 
(e.g., fewer clicks, less time).

Satisfaction: 
Ability to generate a positive 
experience for users.

Sample Website User Test
1. Recruit users.

If possible, they should represent your target audience.
Compensate users for their time if you are able. Generally,
aim for four to six users per test.

2. Schedule users.
Leave enough time between sessions for notetaking and
debriefing with your observers.

3. Welcome the user and explain the test.
Use a script to ensure consistency among all users. The
script should include telling users that they are not being
tested–the user test is a test of the website. Tell users that
they can stop the test at any time. Let them know they
can ask questions, but that you may choose not to answer.

4. The user sits down at a computer or with a
device and is given the tasks (preferably a
printed list).
Sit nearby so you can see both the user and the display.

5. The user works through the tasks and “thinks
aloud.”
This helps you better understand the user’s expectations
and experience. You may prompt the user as needed but
avoid leading the user. Let users fail. Their failure can
demonstrate areas where the designers’ intentions are not
clear. Remember, the website is being tested to see if it
matches user expectations.

6. Be ready to end the test if necessary.
Stop the test if the user is completely frustrated or
unwilling to continue for any reason.

7. Ask any additional questions.
You may ask additional questions after the user has
completed the requested tasks. Generally, you may ask
about how well the website met the user’s expectations.

8. Thank the user.
Thank the user and provide information about
compensation.

9. Debrief with your observers.
Gather overall impressions, ideas, and recommendations.
Answer any questions your observers have. Discuss any
issues with the test or procedure.

10. Report your findings, make changes to the
website, and test again!

User testing is the most direct form of usability testing. Data 
from these tests can not only help improve the website you are 
testing but also inform design decisions for future projects, 
which saves development time and money. Ultimately, user 
testing can help designers and developers create a user-
centered work environment that considers users first. PDP

Training
With JAWS
Roger Tadjbakhsh, 
PDP Senior Education
Specialist

Several years ago, I began working with
Job Access With Speech (JAWS). JAWS is a screen reader
program developed by Freedom Scientific for computer users
whose vision loss prevents them from seeing screen content
or being able to navigate with a mouse. The JAWS screen
reader (which includes a built-in speech synthesizer) enables
an individual who is blind or visually impaired to hear the
text displayed on a computer screen. Once installed, JAWS
recognizes tags embedded in documents and websites. These
tags can indicate the type of object within a document,
describe images, and provide access to form fields. By using
JAWS-specific hotkeys in conjunction with these tags, a user
can read, manage, and update information in a file or a form.
At PDP, we teach people how to work with JAWS so that
they can perform their jobs, whether it is editing a letter in
Word, completing a reimbursement request in Excel or an
online proprietary system, or filling out a client intake form in
a web-based application.

When working with JAWS, it is important to be mindful
of the training challenges that can exist when we compare
experienced JAWS users to those who are learning to use
JAWS for the first time or using JAWS with new state
proprietary applications. I recall working with an experienced
user who had configured the JAWS rate of speech for a high
setting (i.e., fast speaking). Now the user was using JAWS
to read an unfamiliar state system. This combination made
it difficult for me to understand the information being read
aloud by the computer, while also making it difficult for the
trainee to focus on the use of the new application. I quickly
learned that reducing the rate of speech to a lower speed
resulted in a more effective training and an increased level of
comprehension by the trainee.

Whether working with individuals who have vision loss or
others who need to understand how JAWS works to develop
accessible files and applications, knowing that I can meet
their needs is a rewarding experience. My personal training
style has also been affected positively. For example, today as a
trainer I find more value in clarity and quality of instruction
as opposed to the volume of information given. I welcome
the opportunity to support screen reader users and help
government work better. PDP
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Watch Them 
Do Stuff.

Ed Skawinski

User testing is one way to
measure the usability, or ease-
of-use, of a product. Usability is
a quality of how easy a product
is for its intended audience to
use. Usability is also the degree

to which a product meets user expectations. There are
many ways to measure usability, including surveys, expert
evaluations, and focus groups. However, user testing is the
most direct and effective method to measure usability. Any
product can be user tested. For example, companies conduct
user testing for consumer products, websites, web-based
programs, video games, and much more. This article will
focus on user-testing websites.

Usability guru Jakob Nielsen states,
“On the Web, usability is a necessary
condition for survival.”1  If your
website or web-based product (e.g.,
e-learning) is not easy-to-use,

users will be unsatisfied with the experience and may go
elsewhere.

You might be thinking, “If I can use it, then it shouldn’t
be an issue for others.” However, one person’s experience
cannot represent the myriad ways that people use the
web or web-based product. Users access the web on

1 Neilsen, J. (2012, January 3). Usability 101: Introduction to Usability. Retrieved 
from https://www.nngroup.com/articles/usability-101-introduction-to-usability

different devices and in numerous situations. What may
seem obvious to one person may not be obvious to others.
Designers and developers shouldn’t make decisions based
on their perception or use of the product. Instead, they
should make informed decisions based on the behavior of
users who used (or tried to use) the product. User testing
is unique in that the testers (facilitator and observers) are
getting as close as possible to what real users do—or try to
do—with the product. The data gathered from these tests
reduces guessing and opinion-based arguments among
design team members. Developers have the data needed
to improve their product based on the experiences of the
people who will be using the product.

Simply put, user testing consists of 
sitting next to someone to “watch 
them do stuff.”2 A basic user test 
for a website would include a user, a 
computer or other web-enabled device,

a facilitator, other observers, and a list of tasks for the user to 
perform using the website. The user is asked to perform the 
tasks and “talk through” the steps of completing them.

Let’s look at  
the steps involved  
in a user test  
for a website.

2 Chisnell, D. (2008, December 23). Quick Cheap Insightful: Usability Testing in 
the Wild. Retrieved from https://www.slideshare.net/danachisnell/quick-cheap-
insightful-usability-testing-in-the-wild-presentation
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 Is User Testing?

WHY
 Test Usability?

HOW
Do I Conduct  
a User Test?
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3 ISO/IEC 25010. (n.d.). Retrieved from https://www.iso25000.com/index.php/
en/iso-25000-standards/iso-25010?limit=3&start=3
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Tips to
Make
Training
More
Accessible
Carolyn Malloch, Director 
UAlbany Disability Resource Center

The following are tips on making training more accessible 
and usable for the individual attendee.

Survey attendees.
As part of your registration materials, ask if anyone 
requires assistance in the following areas:

• Dietary preference and/or food allergies
• Training materials and presentations:

For example, “Do you need an assistive listening
device or alternative communication assistance, such
as American Sign Language or Communication
Access Realtime Translation (CART)?”

Assess the physical space. 
Make sure the trainings are scheduled in buildings 
that are accessible to people who use wheelchairs or 
have other mobility disabilities.

Assess the technical abilities of the space.
Some buildings have a “loop” built into their audio 
system that individuals with hearing aids can access 
to hear people who use a microphone to speak. Make 
sure speakers use microphones so everyone can hear 
them, even those presenters who state that they don’t 
need a microphone because they can “talk loudly." 

Allow time to hire interpreters. 
If you are providing American Sign Language access 
for individuals who are deaf or low hearing, keep 
in mind that it takes time to schedule a qualified 
interpreter. You can include a deadline for requesting 
the service to allow time to schedule the interpreter or 
cancel if no one needs the service. CART—a real-time 
captioning service—is provided through a computer 
and microphone linked with a trained captioner who 
listens in while transcribing what is being said.

The user reads the typed conversation in real-time on 
a computer screen. Also, consider that you may have 

Carolyn Malloch
Ed Skawinski
 PDP Manager
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1. Recruit users. 
If possible, they should represent your target audience. 
Compensate users for their time if you are able. Generally, 
aim for four to six users per test.

2.	 Schedule users. 
Leave enough time between sessions for notetaking and 
debriefing with your observers.

3.	 Welcome the user and explain the test. 
Use a script to ensure consistency among all users. The 
script should include telling users that they are not being 
tested–the user test is a test of the website. Tell users that 
they can stop the test at any time. Let them know they 
can ask questions, but that you may choose not to answer. 

4.	 The user sits down at a computer or with a 
device and is given the tasks (preferably a 
printed list).
Sit nearby so you can see both the user and the display. 

5.	 The user works through the tasks and “thinks 
aloud.”
This helps you better understand the user’s expectations 
and experience. You may prompt the user as needed but 
avoid leading the user. Let users fail. Their failure can 
demonstrate areas where the designers’ intentions are not 
clear. Remember, the website is being tested to see if it 
matches user expectations.

6.	 Be ready to end the test if necessary.
Stop the test if the user is completely frustrated or 
unwilling to continue for any reason.

7.	 Ask any additional questions. 
You may ask additional questions after the user has 
completed the requested tasks. Generally, you may ask 
about how well the website met the user’s expectations.

8.	 Thank the user.
Thank the user and provide information about 
compensation.

9.	 Debrief with your observers. 
Gather overall impressions, ideas, and recommendations.
Answer any questions your observers have. Discuss any 
issues with the test or procedure.

10.	Report your findings, make changes to the
website, and test again!

User testing is the most direct form of usability testing. Data 
from these tests can not only help improve the website you are 
testing but also inform design decisions for future projects, 
which saves development time and money. Ultimately, user 
testing can help designers and developers create a user-
centered work environment that considers users first. PDP

Training 
With JAWS
Roger Tadjbakhsh,  
PDP Senior Education 
Specialist

Roger Tadjbakhsh

Several years ago, I began working with 
Job Access With Speech (JAWS). JAWS is a screen reader 
program developed by Freedom Scientific for computer users 
whose vision loss prevents them from seeing screen content 
or being able to navigate with a mouse. The JAWS screen 
reader (which includes a built-in speech synthesizer) enables 
an individual who is blind or visually impaired to hear the 
text displayed on a computer screen. Once installed, JAWS 
recognizes tags embedded in documents and websites. These 
tags can indicate the type of object within a document, 
describe images, and provide access to form fields. By using 
JAWS-specific hotkeys in conjunction with these tags, a user 
can read, manage, and update information in a file or a form. 
At PDP, we teach people how to work with JAWS so that 
they can perform their jobs, whether it is editing a letter in 
Word, completing a reimbursement request in Excel or an 
online proprietary system, or filling out a client intake form in 
a web-based application. 

When working with JAWS, it is important to be mindful 
of the training challenges that can exist when we compare 
experienced JAWS users to those who are learning to use 
JAWS for the first time or using JAWS with new state 
proprietary applications. I recall working with an experienced 
user who had configured the JAWS rate of speech for a high 
setting (i.e., fast speaking). Now the user was using JAWS 
to read an unfamiliar state system. This combination made 
it difficult for me to understand the information being read 
aloud by the computer, while also making it difficult for the 
trainee to focus on the use of the new application. I quickly 
learned that reducing the rate of speech to a lower speed 
resulted in a more effective training and an increased level of 
comprehension by the trainee. 

Whether working with individuals who have vision loss or 
others who need to understand how JAWS works to develop 
accessible files and applications, knowing that I can meet 
their needs is a rewarding experience. My personal training 
style has also been affected positively. For example, today as a 
trainer I find more value in clarity and quality of instruction 
as opposed to the volume of information given. I welcome 
the opportunity to support screen reader users and help 
government work better. PDP

User
 Testing:

Sit Next to
Someone.  

Watch Them  
Do Stuff.

Ed Skawinski

User testing is one way to
measure the usability, or ease-
of-use, of a product. Usability is 
a quality of how easy a product 
is for its intended audience to 
use. Usability is also the degree

to which a product meets user expectations. There are 
many ways to measure usability, including surveys, expert 
evaluations, and focus groups. However, user testing is the
most direct and effective method to measure usability. Any 
product can be user tested. For example, companies conduct 
user testing for consumer products, websites, web-based 
programs, video games, and much more. This article will 
focus on user-testing websites.

Usability guru Jakob Nielsen states,
“On the Web, usability is a necessary 
condition for survival.”1  If your
website or web-based product (e.g.,
e-learning) is not easy-to-use, 

users will be unsatisfied with the experience and may go 
elsewhere.

You might be thinking, “If I can use it, then it shouldn’t
be an issue for others.” However, one person’s experience 
cannot represent the myriad ways that people use the 
web or web-based product. Users access the web on 

1 Neilsen, J. (2012, January 3). Usability 101: Introduction to Usability. Retrieved 
from https://www.nngroup.com/articles/usability-101-introduction-to-usability

different devices and in numerous situations. What may
seem obvious to one person may not be obvious to others. 
Designers and developers shouldn’t make decisions based 
on their perception or use of the product. Instead, they 
should make informed decisions based on the behavior of 
users who used (or tried to use) the product. User testing
is unique in that the testers (facilitator and observers) are 
getting as close as possible to what real users do—or try to 
do—with the product. The data gathered from these tests
reduces guessing and opinion-based arguments among
design team members. Developers have the data needed 
to improve their product based on the experiences of the 
people who will be using the product.

Simply put, user testing consists of 
sitting next to someone to “watch 
them do stuff.”2 A basic user test 
for a website would include a user, a 
computer or other web-enabled device, 

a facilitator, other observers, and a list of tasks for the user to 
perform using the website. The user is asked to perform the 
tasks and “talk through” the steps of completing them.

Let’s look at  
the steps involved  
in a user test  
for a website.

2 Chisnell, D. (2008, December 23). Quick Cheap Insightful: Usability Testing in 
the Wild. Retrieved from https://www.slideshare.net/danachisnell/quick-cheap-
insightful-usability-testing-in-the-wild-presentation

WHAT
 Is User Testing?

WHY
 Test Usability?

HOW
Do I Conduct  
a User Test?

2

Did You   
   Know?

Usability: 
The ability of users to 
achieve specified goals 
with effectiveness, 
efficiency, and satisfaction. 

Effectiveness: 
The ability to achieve the objective 
for which it was designed.

Efficiency:
The resources used to reach 
a goal are the lowest possible 
(e.g., fewer clicks, less time).

Satisfaction: 
Ability to generate a positive 
experience for users.

Sample Website User Test

Accessibility: 
The degree to which a product or 
system can be used by people with 
the widest range of characteristics 
and capabilities to achieve a specified 
goal in a specified context of use.

… the difference between3

&

the difference between?31

3 ISO/IEC 25010. (n.d.). Retrieved from https://www.iso25000.com/index.php/
en/iso-25000-standards/iso-25010?limit=3&start=3

Tips to 
Make 
Training 
More 
Accessible
Carolyn Malloch, Director  
UAlbany Disability Resource Center

Carolyn Malloch

The following are tips on making training more accessible 
and usable for the individual attendee.

Survey attendees. 
As part of your registration materials, ask if anyone 
requires assistance in the following areas:

• Dietary preference and/or food allergies
• Training materials and presentations:

For example, “Do you need an assistive listening
device or alternative communication assistance, s
as American Sign Language or Communication
Access Realtime Translation (CART)?”

uch 

Assess the physical space. 
Make sure the trainings are scheduled in buildings 
that are accessible to people who use wheelchairs or 
have other mobility disabilities. 

Assess the technical abilities of the space.
Some buildings have a “loop” built into their audio 
system that individuals with hearing aids can access 
to hear people who use a microphone to speak. Make 
sure speakers use microphones so everyone can hear 
them, even those presenters who state that they don’t 
need a microphone because they can “talk loudly." 

Allow time to hire interpreters. 
If you are providing American Sign Language access 
or individuals who are deaf or low hearing, keep 
n mind that it takes time to schedule a qualified 

f
i
interpreter. You can include a deadline for requesting 
the service to allow time to schedule the interpreter or 
cancel if no one needs the service. CART—a real-time 
captioning service—is provided through a computer 
and microphone linked with a trained captioner who 
listens in while transcribing what is being said. 

er reads the typed conversation in real-time on
uter screen. Also, consider that you may have 

The us
a comp
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PDP Staff Retirements
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Julia Meade

Leanne Friedlander
After nearly 16 years with PDP, 
Leanne Friedlander retired on 
February 5, 2020. Leanne joined 
PDP in May 2004 as a Senior 
Education Specialist with the 
Department of Computer Training 
Services. Leanne was responsible 
for the development of help systems, 
classroom and virtual classroom 
trainings, and the preparation of 
Release Notes for OCFS proprietary 

systems. She also worked with the Division of Child Care 
Services, the Bureau of Adult Services, and Information 
Technology Services staff on systems trainings. Leanne was 
known for being thorough and detailed, and she was an expert 
editor. PDP thanks Leanne for her dedicated service, hard work, 
and contributions.

Leanne Friedlander

Cecilia Archer-Tucker
After 17 years with PDP, Cecilia Archer-Tucker retired on 
March 31, 2020. Cecilia came to PDP in December 2002 
as an Education Specialist and was promoted to a Senior 
Education Specialist in 2005. During her time with PDP, 
Cecilia worked in the Department of Temporary Assistance 
Training and the Department of Child Care Subsidy and 
Regulated Care Training. Cecilia led a variety of curriculum 

design/development and training 
teams, delivered training, coached 
and mentored staff, and aided 
the onboarding of new trainers. 
In addition, Cecilia served PDP 
as a Development Dimensions 
International certified trainer 
and was a contributor to many 
PDP workgroups and strategic 
initiatives. PDP thanks Cecilia 
for her commitment to customer 
service, dedication, and wonderful 
contributions. PDP

Cecilia Archer-Tucker

Tips to Make Training More Accessible
Continued from page 4

videos that need to be captioned before they are shown 
in a training or conference. If an important video is 
demonstrating a process, include a verbal description 
of that process so an individual who is blind or has low 
vision knows what is being demonstrated. The audio of 
the verbal description can be added to the video, just as 
captioning can be added for an individual who is deaf or 
hard of hearing.

Make sure all materials are Section 508 
compliant. 
All documents should be checked for the ability of a 
computer to read the material aloud using a “text-to-
speech” program. This is not as easy as simply creating 
a PDF, Word, or PowerPoint document. To check a 
Microsoft Word document, go to File > Info > Inspect 
Document > Check Accessibility. This will review the 
document, inform you of any accessibility problems that 
might exist, and describe how to fix the problems. To 
check the accessibility of a PDF in Acrobat Pro, choose 
Tools > Accessiblity; in the secondary toolbar, click Full 
Check. PDP

Accomplishing the challenge of meeting these standards has 
been demanding, and government at all levels has turned 
to higher education for direction. Higher education has 
embraced this responsibility and played a role in assisting 
with the ongoing evolution of digital government to provide 
for universal access and usability. Higher education has made
important contributions in applied research on e-government. 
The initial version of e-government was an informational 
“push” model. This model was one-directional and allowed 
for little transaction between citizen-users and government
(e.g., IT professionals and policy leaders). The research 
findings from higher education inf luenced the evolution of
e-government to a more interactive and highly functioning 
model well advanced from the push model. Consequently, as 
increases in IT capacity accelerated over the past decade, so 
did e-government performance. This has led to the current
state of well-directed, interactive, and responsive sites and
applications, including the capability of online interactive 
input from citizen users.

Today, higher education continues to guide the digital 
transition to e-government beyond its research role by 
providing other valuable services such as the establishment of 
benchmarks for e-governance, hosting forums, colloquiums, 
and seminars that bring together IT experts, scholars, policy 

makers, executives, and political 
leaders to exchange ideas about 
best practice. Additionally, 
higher education has provided 
an instructional platform for 
developing IT professionals and
supports the continuing growth of 
these professionals through ongoing state-of-the-art programs 
like those offered by the Departments of Computer Science 
and Electrical and Computer Engineering at the College of 
Engineering and Applied Sciences, University at Albany.

Digital government has become ubiquitous in a short time, and 
the transition, like other paradigm shifts, has not been smooth, 
expedient, nor inclusive. Accessibility and usability are not 
yet universal. As more citizens rely on technology for business 
purposes and civic engagement, government must become 
more proficient in providing these services by means that 
reach all constituents. The ongoing success of e-government 
may come to depend on the effectiveness of higher education 
to work with government on its continuing commitment to 
the development of websites and web applications that enable 
participation for all, thereby achieving the goal of universal 
access and usability. PDP

Achieving Accessibility and 
Usability in E-Government: 
The Digital Challenge
Eugene J. Monaco  
Executive Director and Public Service Professor 
Professional Development Program 

Accessibility and usability have been defined as providing universal access for all, 
including those individuals with disabilities. Traditionally, this has meant physical 
access, as illustrated by the use of ramps and elevators in addition to stairs in 
public buildings and electric lifts on public transportation. A more contemporary 
and inclusive definition includes access to and use of information. Both definitions 
are important to consider when addressing the topic of accessibility and usability 
for those who use government services. As the day-to-day way of conducting 
government business has become increasingly electronic, people with disabilities 
and those who are socially and economically disadvantaged are increasingly at 
risk. The trend toward digital or e-government has presented a new challenge that 
needs to be addressed to provide inclusive service delivery.

E-government has changed what citizens have come to expect 
and demand at local, state, and national levels. The rapid advance 
of the internet into everyday life has brought new ways in which 
government conducts business. The demand for open government 
has spurred the call for transparency, participation, collaboration, 
and increased access by the general public. Therefore, standards 
for accessibility and usability in e-government are essential, and 
Section 508 of the United States Department of Health and 
Human Services Rehabilitation Act of 1973 has proven effective 
in establishing baseline standards that achieve access for all. 

These standards have been formulated at the intersection of 
information technology (IT) developers, political policy leaders, 
and citizen-users. Citizen-users, which include those with 
disabilities and their advocates, are essential to implementing 
access and usability in two ways. First, their feedback is essential 
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Considering the current, unprecedented,
world we are living in, universal 
accessibility and usability is more 
important than ever. This is needed for 
education, government, commerce, as 
well as the general public.
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Achieving Accessibility and Usability in E-Government 
Continued from page 1

when conducting usability testing. Second, they hold 
government accountable for having accessible and usable 
websites. It is the responsibility of citizen-users to provide 
clear, specific, and authentic feedback, and it is IT’s 
responsibility to implement the changes with the support of 
political policy leaders. 

Continued on page 6
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News & Views
PDP Staff Retirements

Julia Meade 
After nearly 16 years with PDP, 
Julia (Julie) Meade retired on 
January 30, 2020. Julie joined 
PDP in February 2004 as a 
Senior Education Specialist 
with the Department of Child 
Welfare. Julie worked on the Case 
Documentation training team 
during her entire career at PDP 
and was an asset to the department 
and training teams as a coach 

and mentor for new trainers. Julie’s years of experience in the 
child welfare field and her desire to meet the needs of workers 
and the families they serve led Julie to provide high-quality 
training and technical assistance. PDP thanks Julie for her 
dedication and her contributions. 

Leanne Friedlander
After nearly 16 years with PDP, 
Leanne Friedlander retired on
February 5, 2020. Leanne joined 
PDP in May 2004 as a Senior 
Education Specialist with the
Department of Computer Training 
Services. Leanne was responsible 
for the development of help systems, 
classroom and virtual classroom
trainings, and the preparation of
Release Notes for OCFS proprietary 

systems. She also worked with the Division of Child Care
Services, the Bureau of Adult Services, and Information 
Technology Services staff on systems trainings. Leanne was 
known for being thorough and detailed, and she was an expert 
editor. PDP thanks Leanne for her dedicated service, hard work, 
and contributions.

Cecilia Archer-Tucker
After 17 years with PDP, Cecilia Archer-Tucker retired on 
March 31, 2020. Cecilia came to PDP in December 2002 
as an Education Specialist and was promoted to a Senior 
Education Specialist in 2005. During her time with PDP, 
Cecilia worked in the Department of Temporary Assistance 
Training and the Department of Child Care Subsidy and 
Regulated Care Training. Cecilia led a variety of curriculum 

design/development and training 
teams, delivered training, coached 
and mentored staff, and aided 
the onboarding of new trainers. 
In addition, Cecilia served PDP 
as a Development Dimensions 
International certified trainer
and was a contributor to many 
PDP workgroups and strategic 
initiatives. PDP thanks Cecilia 
for her commitment to customer 
service, dedication, and wonderful 
contributions. PDP

videos that need to be captioned before they are shown 
in a training or conference. If an important video is 
demonstrating a process, include a verbal description 
of that process so an individual who is blind or has low 
vision knows what is being demonstrated. The audio of 
the verbal description can be added to the video, just as 
captioning can be added for an individual who is deaf or 
hard of hearing.

Make sure all materials are Section 508 
compliant.
All documents should be checked for the ability of a 
computer to read the material aloud using a “text-to-
speech” program. This is not as easy as simply creating
a PDF, Word, or PowerPoint document. To check a 
Microsoft Word document, go to File > Info > Inspect 
Document > Check Accessibility. This will review the 
document, inform you of any accessibility problems that 
might exist, and describe how to fix the problems. To 
check the accessibility of a PDF in Acrobat Pro, choose 
Tools > Accessiblity; in the secondary toolbar, click Full 
Check. PDP
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Accomplishing the challenge of meeting these standards has 
been demanding, and government at all levels has turned 
to higher education for direction. Higher education has 
embraced this responsibility and played a role in assisting 
with the ongoing evolution of digital government to provide 
for universal access and usability. Higher education has made
important contributions in applied research on e-government
The initial version of e-government was an informational 
“push” model. This model was one-directional and allowed 
for little transaction between citizen-users and government 
(e.g., IT professionals and policy leaders). The research 
findings from higher education inf luenced the evolution of 
e-government to a more interactive and highly functioning
model well advanced from the push model. Consequently, as
increases in IT capacity accelerated over the past decade, so
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Achieving Accessibility and 
Usability in E-Government: 
The Digital Challenge
Eugene J. Monaco  
Executive Director and Public Service Professor 
Professional Development Program 

Accessibility and usability have been defined as providing universal access for all, 
including those individuals with disabilities. Traditionally, this has meant physical 
access, as illustrated by the use of ramps and elevators in addition to stairs in 
public buildings and electric lifts on public transportation. A more contemporary 
and inclusive definition includes access to and use of information. Both definitions 
are important to consider when addressing the topic of accessibility and usability 
for those who use government services. As the day-to-day way of conducting 
government business has become increasingly electronic, people with disabilities 
and those who are socially and economically disadvantaged are increasingly at 
risk. The trend toward digital or e-government has presented a new challenge that 
needs to be addressed to provide inclusive service delivery.

E-government has changed what citizens have come to expect 
and demand at local, state, and national levels. The rapid advance 
of the internet into everyday life has brought new ways in which 
government conducts business. The demand for open government 
has spurred the call for transparency, participation, collaboration, 
and increased access by the general public. Therefore, standards 
for accessibility and usability in e-government are essential, and 
Section 508 of the United States Department of Health and 
Human Services Rehabilitation Act of 1973 has proven effective 
in establishing baseline standards that achieve access for all. 

These standards have been formulated at the intersection of 
information technology (IT) developers, political policy leaders, 
and citizen-users. Citizen-users, which include those with 
disabilities and their advocates, are essential to implementing 
access and usability in two ways. First, their feedback is essential 
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Considering the current, unprecedented,
world we are living in, universal 
accessibility and usability is more 
important than ever. This is needed for 
education, government, commerce, as 
well as the general public.
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Tips to Make Training More Accessible
Continued from page 4

Achieving Accessibility and Usability in E-Government 
Continued from page 1

when conducting usability testing. Second, they hold 
government accountable for having accessible and usable 
websites. It is the responsibility of citizen-users to provide 
clear, specific, and authentic feedback, and it is IT’s
responsibility to implement the changes with the support of
political policy leaders. 
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